Proceeding of 4th International Conference on Research and Development (ICORAD)
Vol. 3 No. 2 (2024)

Page : 438-453

ISSN:2828-4925

DOI: 10.47841/icorad.v3i2.211

The Influence of Brand Image, Spill Over Effect, and Product Quality on
Purchasing Decisions Mediated by Consumer Culture on Wardah
Skincare (Case Study of Wardah Skincare Product Users in Pati Regency)

Enno Aprilianal, Qristin Violindaz?, Rr. Hawik Ervina Indiworo3
123 Semarang PGRI University, Semarang, Indonesia
Corresponding email : ennoaprilianal103@gmail.com
Received: December,2, 2024 | Revised: December,18, 2024 | Accepted: December,20, 2024

Abstract. The purpose of this study is the influence of brand image, spill over effect, and product
quality on purchasing decisions mediated by consumer culture on Wardah skincare (case study of
Wardah skincare product users in Pati Regency). This study used a sample of 130 respondents . With
the probability sampling technique, the simple random sampling method uses SmartPLS 4 software.
The results of this study are that brand image does not have a significant effect on purchasing
decisions, spill over effect does not have a significant effect on purchasing decisions, product quality
has a significant positive effect on purchasing decisions, brand image has a significant positive effect
on consumer culture, spill over effect does not have a significant effect on consumer culture, product
quality has a significant positive effect on consumer culture, consumer culture has a significant
positive effect on purchasing decisions, consumer culture does not mediate the influence of brand
image on purchasing decisions, consumer culture can mediate the influence of spill over effect on
purchasing decisions, and consumer culture can mediate the influence of product quality on
purchasing decisions.

Keywords: Brand Image; Spill Over Effect; Product Quality; Consumer Culture; Purchase Decisions

INTRODUCTION

The proliferation of skincare products circulating in the market today is very diverse
in terms of brands, types, and uses as well as colors and shapes. The many types of beauty
products circulating affect a person's attitude towards using goods and purchasing
decisions. Consumers are more likely to make purchases or repeat purchases when they
have positive thoughts about the brand. By participating in purchasing activities, consumers
decide what to buy.

Figure 1: Beauty Industry Market Share
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Based on information provided by the Central Statistics Agency (BPS), the Indonesian
cosmetics industry experienced a growth of 9.61% in 2021 with an increase in the number
of beauty industry companies by 20.6%. The Micro, Small, Medium Enterprises (MSMEs)
sector also has quite large potential in the Indonesian cosmetics industry. Wardah is a local
beauty product brand founded by Nurhayati Subakat in 1995.

Nowadays, consumers are very wise and careful in choosing skincare products. If
consumers do not have experience with a product, they tend to trust well-known and
popular brands or good brand images (Dwi Indah Utami & Hidayah, 2022). This is what
makes manufacturers create new innovations and always follow the times in order to
understand and fulfill consumer desires so that they can get a positive brand image in the
minds of consumers.

One of the skincare brands that has undergone many changes with the release of
innovations that are in accordance with the needs and desires of consumers is Wardah
skincare. Wardah is one of the local brands that carries a halal brand image on its products
and has been registered with BPOM (Food and Drug Supervisory Agency) with Halal
certification. Therefore, in order to be free from fake products, consumers must choose those
whose safety has been guaranteed and have BPOM Wardah products that have obtained a
safe permit for use from BPOM which focuses on body and facial skin care. This local brand
skincare can attract the attention of Indonesian consumers, Wardah instills halal values in
the products they sell. This makes consumers feel safe when using their products.

This Wardah product is ranked fourth as the best skincare brand in the April 2024
period and ranked fourth as the local brand with the most sales and sought after by
consumers in the facial care and cosmetics/skincare category according to the results of the
Compas research in the 2024 period.

Table 1
Beauty Product Brand Domination
April 2024
Product Brand Market Share (Sales Value)

Skintific 1.47 Billion

The Origin 502.7 Million
Scarlett 340.4 Million
Wardah 145 Million

Source: markethac.id, 2024

In local brands, products consist of Skintific, The Originote, Scarlett, and
WardahinThis year, it seems that Indonesians still trust local products to take care of
themselves. According to Skintific product sales data, this brand is firmly at the top of sales
with a market share of 1.47 billion. In second place, there is The Originote which is worth
502.7 million, Scarlett is 340.4 million, and followed by Wardah with 145 million. It is
interesting to note that Wardah, a local facial care brand that has been established since
1995, was able to beat its competitors, which are international brands. Meanwhile, Wardah
is considered an old product, whose sales have decreased, other brands that are included in
the best-selling products based on the number of products sold include Skintific, The
Originote, and Scarlett.

439



Proceeding of 4th International Conference on Research and Development (ICORAD)
Vol. 3 No. 2 (2024)

Page : 438-453

ISSN:2828-4925

DOI: 10.47841/icorad.v3i2.211

Figure 2: Best-Selling Local Skincare Sales Data on E-Commerce

SKINTIFIC  24,56%
ELFORMULA 21,34% |

THE ORIGINOTE

Em

LABORE 2% J

FEALI

16% )
AT 2,57% |
2,35%

NPURI

Glag2Glow

Source: markethac.id, 2024

Local products that are currently popular with people of various ages, both teenagers
and adults, namely from the 10 best-selling local skincare brands on E-Commerce, there are
Skintific, Elformula, The Originote, Scarlett Whitening, Labore, Feali, Bio Aqua, Wardah,
Npure and Glay2Glow products sought by consumers. According to the results of Compass
research, co.id in the 2024 period. Wardah is in eighth position in the overall sales ranking
of Local Skincare Brands with 2.42% points even though Wardah is an original Indonesian
halal cosmetic brand that was founded in 1995 under PT. Paragon Technology and
Innovation (PT. PTI). Founded by Nurhayati Subakat who currently serves as Commissioner
of PT. PTI, Wardah always prioritizes quality to support women to look beautiful according
to their character. Products that have been launched in Indonesia for a long time compared
to Skintific. In the results of the table above, it can be seen that Wardah is still not good
compared to other products.

Figure 3: Best Selling Skincare Sales Data in 2024
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Wardah's sales data in the 2024 period experienced a significant decline in sales and
occurred in total sales on the e-commerce platform in Indonesia which was ranked fourth,
with sales 0of 456.781 million. In this case, Wardah's skincare products experienced a decline
and a shift in interest in buying Wardah products. This decline in sales was due to the
presence of newly launched local skincare products, namely Hanasui, Pinkflash, Oh My Glam.
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This problem resulted in Wardah's skincare products, because Wardah had been established
earlier and skincare products that were already well-known among consumers turned out
to experience problems in declining sales in competing with other newly launched skincare
products.

Wardah's lagging sales can be interpreted as meaning that Wardah is not yet perfect
in attracting repeat purchase decisions from consumers, advertisements that do not
influence consumer memory, consumer perceptions of brand image and product quality
offered by Wardah can be one of the influences in making purchasing decisions. Various
methods are used by companies to get consumer attention in order to provide a good
product image, so that many consumers use the product.

Spillover effect becomes an economic event caused by a series of concepts and
policies or economic turmoil in a country through trade channels, this spillover effect has the
potential to spread to neighboring countries (Novianti, 2017). Spillover effect is a second
effect that follows the primary effect and can be removed in time or place from the event that
caused the primary effect. This event is inseparable from volatility where volatility describes
the magnitude of price changes that indicate market fluctuations in a certain period.
Understanding the behavior of spillover effects and volatility of returns is very important for
investors in making asset allocation decisions, in implementing hedging strategies and in
formulating policies related to capital inflows into the market.

The use of Wardah skincare products can affect social perception, in marketing
Wardah products also have an impact on consumer preferences for other brands that can
become more aware and interested in Wardah skincare products. Wardah skincare product
sales data that is successful in marketing its products affects the cosmetics industry as a
whole Wardah has succeeded in increasing awareness of the importance of white skin care,
driving growth in demand for similar products or influencing pricing strategies in the
market.

There are many considerations in determining the decision to purchase a product,
one of which is product quality. According to Tjiptono & Chandra (2016) in(Widya et al,,
2023), product quality is the ability of a product to provide results that are in accordance
with what is expected by customers, and can even exceed customer expectations. Wardah
has natural and halal basic ingredients, its products are made for the comfort and peace of
mind of women who use them. Before its products are marketed, Wardah must conduct blind
tests to ensure the safety and quality of its products. This is done because Wardah's main
priority is consumer safety and this is a must. Each Wardah product has a different type of
content that is adjusted to the focus of the skin problem that is to be solved. In several other
body care products, Wardah also has its own appeal in the form of price, affordable, quality,
and halal. These advantages make the quality of Wardah products much in demand by
consumers.

Purchasing decisions are decisions made by consumers in purchasing a product.
Before making a purchasing decision, consumers will certainly think about various
considerations regarding products that suit their desires and needs. In addition, consumer
purchasing decisions are important in terms of company progress, because the more
consumers want to buy products or services in a company, the greater the opportunity for
the company to gain profit and loyal customers (Authors & Gunawan, 2017) in
research(Agustin & Komalasari, 2020). Purchasing Decision is the final stage for consumers
to compile a list of items in their preferred ranking, where the final stage will create
purchasing interest, so that consumers will buy items that match their desires and needs.
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Kotler and Keller emphasize that culture is the biggest influencing factor on consumer
behavior, because culture shapes a person's view of the world and what is considered
important in life. They also emphasize that in marketing, companies must understand
consumer culture in order to design effective marketing strategies.

Based on the research problem, the author conducted a study with the title: "The
Influence of Brand Image, Spill Over Effect, and Product Quality on Purchasing Decisions
Mediated by Consumer Culture on Wardah Skincare (Case Study of Wardah Skincare Product
Users in Pati Regency".

METHOD
Research Design

This research design uses a quantitative research method. The following is the research
model developed.

Figure 4: Research Model Development

Source: Data processed in (2024)

Population, Sample, Sampling Techniques

The population in this study were users or customers of Wardah skincare products in
Pati Regency. According to Sugiyanto (2018) in (Imron, 2019), the population is a
generalization area consisting of objects or subjects that have certain qualities and
characteristics determined by researchers to be studied and then conclusions drawn. The
population in this study is spread out and the number is not known for certain, researchers
can use samples taken from the population (Sugiyono, 2013) in (Imansyah &
Pudjoprastyono, 2023). So sampling was carried out for the study. The sample was
calculated using the Slovin formula with a margin of error of 10% and the results were 130
respondents.because the more samples used, the more accurate and precise the estimate
obtained. In other words, the more samples taken, the smaller the estimation error (or the
difference between the sample estimate and the actual population parameter according to
Jakob Bernoulli, Gay and Diehl (1992).

Data collection technique

In this study, primary data was used, namely a questionnaire (survey) written in the
form of a series of questions about a particular thing to be answered which was made online
via Google from and distributed via social media. The questionnaire in this study was given
to users or customers of Wardah skincare products in Pati Regency. In this study, a Likert
scale with 6 scores was used.
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Analysis Techniques

In this study, according to (Ghozali, 2015) in (Ermawati, 2018), outer model
measurements (Construct Reliability and Validity, Discriminant Validity, Cronbach's Alpha,
Composite Reliability, Inner Model (R-Square and F-Square), and Hypothesis Testing (Direct
Effect, Indirect Effect, and Total Effect) were used using SmartPLS 4 (Partial Least Square)
software.

RESULTS AND DISCUSSION

The research data was obtained through the distribution of online questionnaires to
users of Wardah facial care products in Pati Regency. In collecting data, researchers obtained
130 respondents and then tabulated and processed using SmartPLS 4 software. The data
analysis method applied used the Outer Model (Construct Reliability and Validity,
Discriminant Validity, Cronbach's Alpha, Composite Reliability, Inner Model (R-Square and
F-Square), and Hypothesis Testing (Direct Effect, Indirect Effect, and Total Effect).

Outer Model
According to (Ghozali, 2015) in the research (Ermawati, 2018) the outer model is a
test of the measurement model to assess the validity and reliability of constructs and
indicators.
Table 2
Construct Reliability and Validity

Cronbach' Composite Composite Average variance

s alpha reliability (rho_a) | reliability (rho_c) extracted (AVE)
Bran&i‘;‘age 0.821 0.828 0.882 0.653
Esfrggito(‘)’(ezr) 0.854 0.858 0.901 0.696
Qlfarl(i’t‘;“(c);) 0.922 0.925 0.939 0.721
gl‘;l‘tlz‘r*én(ezr) 0.914 0.918 0.940 0.796
Dggirscif)‘f&) 0.878 0.882 0.908 0.622

Source: Data Results Processed with SmartPLS 4

Based on the data processing above, it shows where the Reliability Test is based on
Cronbach's Alpha and Composite Reliability where the testing criteria are the Cronbach's
Alpha value must be> 0.7. The Cronbach's Alpha value of each variable, independent,
mediation, dependent is more> 0.7, the assumption of the reliability test based on
Cronbach's Alpha has been met or is valid. The Composite Reliability value> 0.6, the
Composite Reliability assumption has been met or is valid.
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Table 3
Convergent Validity
Variables Question Items Outer Loading Caption
BI SOE KP BK KPB

Brand Image BL.1 0.800 Valid
(X1) BIL.2 0.843 Valid
BL.3 0.871 Valid
Bl.4 0.710 Valid
Spill Over SOE.1 0.756 Valid
Effect (X2) SOE.2 0.881 Valid
SOE.3 0.845 Valid
SOE.4 0.851 Valid
Product Quality KP.1 0.839 Valid
(X3) KP.2 0.847 Valid
KP.3 0.797 Valid
KP.4 0.845 Valid
KP.5 0.873 Valid
KP.6 0.889 Valid
Consumer BK.1 0.864 Valid
Culture (Z) BK.2 0.926 Valid
BK.3 0.929 Valid
BK.4 0.846 Valid
Purchase KPB.1 0.868 Valid
Decision (Y) KPB.2 0.736 Valid
KBP.3 0.788 Valid
KBP.4 0.788 Valid
KBP.5 0.771 Valid
KPB.6 0.776 Valid

Source: SmartPLS 4 Data Processing Results

Based on the data processing above from 5 variables with convergent validity testing
criteria > 0.7, it can be said that the convergent validity assumption based on the data loading

factor is valid.

Table 4
Discriminant Validity
Variables Brand Spill Over Product Consumer Buying
Image Effect Quality Culture decision
Brand Image
Spill Over 0.908
Effect
Product 0.872 0.854
Quality
Consumer 0.878 0.856 0.937
Culture
Buying 0.895 0.871 0.969 0.965
decision

Source: Data Results Processed with SmartPLS 4
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Based on the data processing above, the discriminant validity test HTMT <0.90, the
assumption of the discriminant validity test is known to be not good, namely Brand Image -
Spill Over Effect of 0.098, Product Quality - Consumer Culture of 0.937, Product Quality
Purchase Decision of 0.969, Consumer Culture - Purchase Decision of 0.965. so that the
discriminant validity must be dropped first before being tested further.

Inner Model
Inner model as a structural analysis of the model, which aims to predict the
relationship between latent variables (Ghozali, 2015).

Table 5
R-Square Test Results
Variables R-square R-square adjusted
Consumer Culture (Z) 0.784 0.779
Purchase Decision (Y) 0.823 0.818

Source: Data Results Processed with SmartPLS 4

Based on the results of the data processing above, it can be shown as follows:

1. The Adjusted R-Square value with the Consumer Culture (Z) variable of 0.779 is good
or strong because 0.779 > 0.75.

2. The Adjusted R-Square value between Consumer Decision variables is 0.818, which
is strong or good because 0.818 > 0.75.

Table 6
F-Square Test Results (Effects Size)
. Brand Spill Product Consumer . . .
Variables Image Over Quality Culture Buying decision
Effect
Brand Image 0.056 0.018
Spill Over Effect 0.045 0.014
Product Quality 0.564 0.227
Consumer
Culture 0.158
Buying decision

Source: Data Results Processed with SmartPLS 4

Based on the data processing above, it can be shown

1. The F-Square value between Brand Image (X1) and Consumer Culture (Z) is 0.056,
which is considered to have a low or small influence because 0.056 > 0.02.

2. The F-Square value between the Spill Over Effect (X2) and Consumer Culture (Z) is
0.045, which is considered a low or small influence because 0.045 > 0.02.

3. The F-Square value between Product Quality (X3) and Consumer Culture (Z) is 0.564,
which is a large or strong influence because 0.564 > 0.35.

4. The F-Square value between Brand Image (X1) and Purchasing Decision (Y) is 0.018,
which is considered to have a low or small influence because 0.018 > 0.02.

5. The F-Square value between the Spill Over effect (X2) and the Purchase Decision (Y)
is 0.014, which is a low or small influence because 0.014>0.02.
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6. The F-Square value between Product Quality (X3) and Purchasing Decision (Y) is
0.227, which is a moderate influence because 0.227> 0.15.
7. The F-Square value between Consumer Culture (Z) and Purchasing Decisions (Y) is
0.158, which is a moderate influence because 0.158> 0.15.

Hypothesis Testing
Table 7
Direct Effects Test Results
Variables el SELpLE (Slzrlil:tail;?l SIS P values
sample (0O) | mean (M) (STDEV) (10/STDEVI)
Brand Image -> 0.187 0.193 0.082 2.271 0.023
Consumer Culture
Brand Image -> 0.097 0.107 0.087 1112 0.266
Purchase Decision
Spill Over Effect -> 0.167 0.180 0.095 1,770 0.077
Consumer Culture
Spill Over Effect -
>Purchase 0.086 0.100 0.082 1,054 0.292
Decision
Product Quality -> | ) oo 0.574 0.122 4.866 0.000
Consumer Culture
Product Quality -> | =, ¢ 0.423 0.125 3,400 0.001
Purchase Decision
Consumer Culture
-> Purchasing 0.359 0.338 0.108 3.337 0.001
Decisions

Source: Data Results Processed with SmartPLS 4

The results of the data processing above can be shown with the Path Coefficients path

based on (Direct Effects) in the table which can be seen from the T-Statistic as follows:

1.

X1 against Z: P Value Brand Image (X1) with Consumer Culture (Z) with T-Statistic
value of 2.271>1.96 and P Value of 0.023<0.05. Brand Image (X1) has a significant
effect on Consumer Culture (Z) directly.

X1 against Y: P Value Brand Image (X1) with Purchase Decision (Y) with T-Statistic
value of 1.112<1.96 and P Value of 0.266>0.05. Brand Image (X1) does not have a
significant effect on Purchase Decision (Y) directly.

X2 against Z: P Value Spill Over Effect (X2) with Consumer Culture (Z) with T-Statistic
value of 1.770<1.96 and P Value of 0.077>0.05. Spill Over Effect (X2) does not have a
significant effect on Consumer Culture (Z) directly.

X2 against Y: P Value Spill Over Effect (X2) with Purchase Decision (Y) with T-Statistic
value of 1.054<1.96 and P Value of 0.292>0.05 Spill Over Effect (X2) does not have a
significant influence on Purchase Decision (Y) directly.

X3 against Z: P Value of Product Quality (X3) with Consumer Culture (Z) with T-
Statistic value of 4.866>1.96 and P Value of 0.000<0.05. Product Quality (X3) has a
significant positive effect on Consumer Culture (Z) directly.
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6. X3 against Y: P Value of Product Quality (X3) with Purchase Decision (Y) with T-
Statistic value of 3.400>1.96 and P Value of 0.001<0.05. Product Quality (X3) has a
significant positive effect on Purchase Decision (Y) directly.

7. Z against Y: P Value of Consumer Culture (Z) with Purchasing Decision (Y) with T-
Statistic value of 3.337>1.96 and P Value of 0.001<0.05. Consumer Culture (Z) has a
significant positive effect on Purchasing Decision (Y) directly.

Figure 5: Structural Equation Model

Source: Data Results Processed with SmartPLS 4

Table 6
Indirect Effect Test Results

Original Sample SLERLE T statistics

sample (0) | mean (M) deviation P values

Variables
(STDEV) (10/STDEVI)

Brand Image ->
Consumer
Culture ->
Purchase
Decision

Spill Over Effect
-> Consumer
Culture -> 0.060 0.062 0.040 1,505 0.132
Purchasing
Decision
Product Quality -
> Consumer
Culture -> 0.167 0.180 0.095 1,770 0.077
Purchase
Decision

0.067 0.065 0.036 1,885 0.060

Source: Data Results Processed with SmartPLS 4
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Based on the results with Indirect Effects, the following conclusions can be drawn:

1. Brand Image (X1) -> Consumer Culture (Z) -> Purchasing Decision (Y) from the T-
Statistic value of 1.885 with a P Value of 0.060>0.05 is not significant, so Consumer
Culture does not mediate the influence of Brand Image on a Purchasing Decision.

2. Spill Over Effect (X2) -> Consumer Culture (Z) -> Purchasing Decision (Y) from the T-
statistic value of 1.505 with a P Value of 0.132 <0.05, it is significant that Consumer
Culture mediates the influence of Spill Over Effect on a Purchasing Decision.

3. Product Quality (X3) -> Consumer Culture (Z) -> Purchasing Decision (Y) from the T-
Statistic value of 2.881 with a P Value of 0.004 <0.05 significant, then Consumer
Culture mediates the influence of Product Quality on a Purchasing Decision.

Table 8

Total Effects

Variables

Original
sample (0)

Sample
mean (M)

Standard
deviation
(STDEV)

T statistics
(10/STDEVI)

P values

Brand Image -
> Consumer
Culture

0.187

0.193

0.082

2.271

0.023

Brand Image -
> Purchase
Decision

0.164

0.172

0.094

1,754

0.080

Spill Over
Effect ->
Consumer
Culture

0.167

0.180

0.095

1,770

0.077

Spill Over
Effect->
Purchase
Decision

0.147

0.162

0.090

1,636

0.102

Product
Quality ->
Consumer
Culture

0.595

0.574

0.122

4.866

0.000

Product
Quality ->
Purchase
Decision

0.640

0.617

0.126

5,058

0.000

Consumer
Culture->
Purchase
Decisions

0.359

0.338

0.108

3.337

0.001

Based on the results above, the Total Effects can be concluded as follows:

Source: Data Results Processed with SmartPLS 4

1. The relationship between Brand Image (X1) and Consumer Culture (Z) has a T-
Statistic value of 2.271 and a P Value of 0.023<0.05 which has a significant influence.
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2. The relationship between Brand Image (X1) and Purchasing Decision (Y) has a T-
Statistic value of 1.754 and a P Value of 0.080>0.05 which does not have a significant
effect.

3. The relationship between the Spill Over Effect (X2) and Consumer Culture (Z) has a
T-Statistic value of 1.770 and a P Value of 0.077>0.05 which does not have a
significant effect.

4. The relationship between Spill Over Effect (X2) and Purchasing Decision (Y) has a T-
Statistic value of 1.636 and a P Value of 0.102>0.05 which does not have a significant
effect.

5. The relationship between Product Quality (X3) and Consumer Culture (Z) has a T-
Statistic value of 4.866 and a P Value of 0.000<0.05 which has a significant influence.

6. The relationship between Product Quality (X3) and Purchasing Decisions (Y) has a T-
Statistic value of 5.058 and a P Value of 0.000<0.05 which has a significant influence.

7. The relationship between consumer culture (Z) and purchasing decisions (Y) hasa T-
statistic value of 3.337 and a P value of 0.001<0.05 which has a significant influence.

DISCUSSION
The Influence of Brand Image on Purchasing Decisions

From the partial research results, it shows that Brand Image does not affect
Purchasing Decisions. This means that there is no influence between Brand Image and
Purchasing Decisions on Wardah skincare products in Pati Regency. The results of this study
strengthen previous research conducted by Budi Istiyanto, Lailatan Nugroho (2016) and
research by Valentine Parengkuan, Altje Tumbel, Rudy Wenas (2014), which showed that
Brand Image does not affect Purchasing Decisions. The results of this study show that the
results of the research questionnaire show that the Brand Image variable does not affect
Purchasing Decisions. Wardah products that uphold the halal brand image on their products.
In addition, consumers in determining purchasing decisions are not only based on Brand
Image but also based on trust, as well as whether or not consumers are suitable to use the
skincare products used.

The Influence of the Spill Over Effect on Purchasing Decisions

From the partial research results, it shows that Spill Over Effect has no effect on
Purchasing Decisions. This means that there is no influence between Spill Over Effect and
Purchasing Decisions on Wardah skincare products in Pati Regency. According to Chandon
etal. (2000) in the study that the Spill Over Effect effect has no significant impact on changing
consumer purchasing decisions, especially when consumers already have strong
preferences. The results of the research questionnaire show that the Spill Over Effect
variable has no effect on Purchasing Decisions because Spill Over Effect with the situation at
the time of purchase can moderate the influence of Spill Over Effect. Consumers or users of
Wardah skincare products in Pati Regency often prioritize product value and quality over
external influences.

The Influence of Product Quality on Purchasing Decisions

The results of the partial study show that the Product Quality variable on Purchasing
Decisions has a positive and significant effect. This means that there is an influence between
Product Quality and Purchasing Decisions on Wardah skincare products in Pati Regency. The
results of the study by Refomasianto & Puspitadewi (2022) showed that there was a
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relationship between the product quality variable and the purchasing decision variable. The
results of the research questionnaire showed that the Product Quality variable influenced
Purchasing Decisions because the better or higher the product quality offered to the public,
the higher their decision to buy the product.

The Influence of Brand Image on Consumer Culture

The partial research results show that the Brand Image variable on Consumer Culture
has a positive and significant effect. This means that there is an influence between Brand
Image and Consumer Culture on Wardah skincare products in Pati Regency. The results of
the study according to Kotler and Keller (2016) there is a significant influence of brand image
on consumer culture. The results of the research questionnaire show that the Brand Image
variable affects Consumer Culture because a strong Brand image helps create a clear identity
for the brand image. Consumers of Wardah skincare products in Pati Regency often associate
certain values and characteristics with brand image, which can affect the way they behave
and interact in a cultural context. Consumer culture can be influenced by the brand image
chosen by social groups, because consumers tend to want to be accepted and recognized by
the people around them.

The Influence of Spill Over Effect on Consumer Culture

The partial research results show that Spill Over Effect has no effect on Consumer
Culture. This means that there is no influence between Spill Over Effect and Consumer
Culture on Wardah skincare products in Pati Regency. The research results reveal according
to Thompson et al. (2005 the influence of spillover effect which means that in some
situations, consumers are not significantly affected by consumer culture. The results of the
research questionnaire show that the Spill Over Effect variable has no effect on Consumer
Culture because consumers who already have high loyalty to a particular brand image may
not be affected by information or promotions from other brands, so that the spill over effect
becomes irrelevant in the cultural context.

The Influence of Product Quality on Consumer Culture

From the partial research results, it shows that the variable of Product Quality on
Consumer Culture has a positive and significant effect. This means that there is an influence
between Product Quality and Consumer Culture on Wardah skincare products in Pati
Regency. The results of the study found according to Holt (2002) that product quality has an
effect on consumer culture. The results of the research questionnaire show that Product
Quality on Consumer Culture is because Wardah's quality of issuing products according to
Indonesian skin can affect the use of Wardah products.

The Influence of Consumer Culture on Purchasing Decisions

The partial research results show that the Consumer Culture variable on Purchasing
Decisions has a positive and significant effect. This means that there is an influence between
Product Quality and Consumer Culture on skincare products in Pati Regency. The results of
the research by Purimahua (2005) and Sriwardiningsih, et al. (2006) show that consumer
culture influences purchasing decisions. The results of the research questionnaire show that
Consumer Culture influences Purchasing Decisions because Wardah is halal certified, thus
creating a culture for self-care that reflects a healthy lifestyle.
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The Influence of Brand Image on Purchasing Decisions Mediated by Consumer Culture

From the partial research results, it shows that Consumer Culture does not mediate
the influence of Brand Image on Purchasing Decisions, it does not affect Wardah skincare
products in Pati Regency. The research results that support according to Kotler and Keller
(2016) In stating that the influence of brand image on purchasing decisions, emphasize that
consumer culture cannot mediate, because the influence of brand image is not significant if
consumer culture does not support the values associated with brand image. The results of
the Wardah user research questionnaire still have different preferences or needs compared
to other markets.

The Influence of Spill Over Effect on Purchasing Decisions Mediated by Consumer
Culture

From the partial research results, it shows that the Consumer Culture variable can
mediate the influence of Spill Over Effect on Purchasing Decisions, which has a positive and
significant effect on Wardah skincare products in Pati Regency. Keller's research results
(2003) state that the spillover effect of brands that have a positive image can significantly
influence purchasing decisions for other brands. Consumer culture acts as a mediator that
determines how much impact this spill over effect has. The results of the Spill Over Effect
research questionnaire on Purchasing Decisions through Consumer Culture are encouraged
to try to make purchasing decisions with consumer cultural habits of using skincare.

The Influence of Product Quality on Purchasing Decisions Mediated by Consumer
Culture

From the partial research results, it shows that the Consumer Culture variable can
mediate the influence of Product Quality on Purchasing Decisions, which has a positive and
significant effect on Wardah skincare products in Pati Regency. Research according to Kotler
and Keller (2016) states that product quality influences purchasing decisions that consumer
culture can mediate significantly. The results of the Wardah research questionnaire have
product quality and specifications according to good durability which can increase concern
for skin care to form consumer cultural perceptions in Pati Regency because values and
culture can influence the way consumers assess product quality.

REFERENCES

Agustin, K., & Komalasari, E. (2020). Analysis of the Influence of Promotion on Purchasing
Decisions in Small and Medium Enterprises (SMEs) at Rattan Handmade Pekanbaru.
6(2),97-106.

Antou, RR, & Tasik, HHD (2017). Spillover Analysis on Stocks Included in the LQ45 and Non-
LQ45 Indexes. EMBA Journal, 5(2), 2713-2720. www.idx.co.id

Chintya Novalia, I., & Muhtarom, A. (2020). The Influence of Brand Image, Price, and Service
Quality on Consumer Purchasing Decisions at CV. Boga Lestasi. Student Economics
Journal (JEKMA), 1(1), 1-13.

Dainty Julliet Roring, G., Christie Natalia Rumagit, M., & Artha Malau, N. (2023). Spillover
Effect Analysis of Economic Growth of Cities and Regencies in North Sulawesi Province
(Manado, Bitung, Minahasa, North Minahasa). Journal of Economics and Business UBS,
2(6), 3533-3542. https://doi.org/10.52644 /joeb.v2i6.800

Dian Alfia Purwandari, & Achmad Nur Hidayaht. (2024). Skincare Product Consumption
Patterns Based on Social & Cultural Adolescent Girls. CENDEKIA: Journal of Social

451



Proceeding of 4t International Conference on Research and Development (ICORAD)
Vol. 3 No. 2 (2024)

Page : 438-453

ISSN:2828-4925

DOI: 10.47841/icorad.v3i2.211

Sciences, Language and Education, 4(2), 211-230.
https://doi.org/10.55606/cendekia.v4i2.2918

Dr. Duryadi, MS (2021). Scientific Research Methods Empirical Research Methods Path
Analysis Model and Analysis Using SmartPLS. In Yayasan Prima Agus Teknik Publisher
(Vol. 7, Issue 1).

Effendi, ZR, Sentosa, E., & Nursina. (2022). The Influence of Brand Image, Product Quality,
and Promotion on Consumer Purchasing Decisions at Seikou Coffee Depok. Ikraith-
Ekonomika, 5(1), 31-38.

Ermawati, A. (2018). Discriminant Validity, Convergent Validity, Composite Reliability.
Agora Journal, 6(2), 287097.

Fuji Lestari, L., & Baidlowi, I. (2023). The Influence of Brand Image and Product Quality on
Purchase Decisions for iPhone Products with Lifestyle as an Intervening Variable.
Journal of Global Humanistic Studies Philosophiamundi.ld, 3(1), 1.

Scientific, J., & Dan, E. (2024). The Influence of Scarlett Product Brand Image on Purchasing
Decisions of Young Women. 2(1), 242-247.

Imansyah, B., & Pudjoprastyono, H. (2023). The Influence of Brand Image, Product Quality
and Price Perception on Purchasing Decisions of Wardah Cosmetics. Journal of
Management and Bussines (JOMB), 5(1), 335-349.

Imron, I. (2019). Analysis of the Influence of Product Quality on Consumer Satisfaction Using
Quantitative Methods at CV. Meubele Berkah Tangerang. Indonesian Journal on
Software Engineering (IJSE), 5(1), 19-28. https://doi.org/10.31294 /ijse.v5i1.5861

Irawan, MRN (2020). The Influence of Product Quality, Price and Promotion on Consumer
Purchase Interest at PT. Satria Nusantara Jaya. Ekonika: Journal of Economics, Kadiri
University, 5(2), 140. https://doi.org/10.30737 /ekonika.v5i2.1097

Kaumbur, OM (2018). ON THE DECISION TO BUY BEAD CRAFTS (Case Study at Leni
Tenggarong Bead Craft Shop). 1-11.

Keren, K., & Sulistiono, S. (2019). The Influence of Motivation, Culture, and Consumer
Attitudes on Purchase Decisions of Indomie Products. Scientific Journal of Unitary
Management, 7(3), 319-324. https://doi.org/10.37641 /jimkes.v7i3.284

Khaerani, RA, & Prihatini, AE (2020). The Influence of Promotion and Brand Image on
Purchasing Decisions on Traveloka Services. Journal of Business Administration, 9(3),
310-317. https://doi.org/10.14710/jiab.2020.28097

Khotimah, H., & Prastuti, D. (2020). The effect of product quality, service quality, and price
on customer satisfaction at PT. Biro Klasifikasi Indonesia (Persero), North Jakarta.
Indonesian College of Economics, 1-21.

Maulidiyah Ayu Saraswati, & Matheous Tamonsang. (2024). The Influence of Product
Quality, Price, and Social Media Marketing on Purchase Decisions of Scarlett Whitening
Skincare Products and Purchase Interest as an Intervening Variable. Journal of
Management Research, 2(2), 113-131. https://doi.org/10.54066/jurma.v2i2.1810

Muttaqin, AA, Fitriadi, BW, & Yusnita, RT (2023). Factors That Influence The Decision To
Purchase Syar'i Products On Tasikmalaya Centennial (Survey On lait Femele Students
In Tasikmalaya City). Journal of Management, Economics, and Accounting, 2(1), 33-44.

Putri Adilla, & Christiawan Hendratmoko. (2023). The Influence of Brand Image, Price,
Product Quality and Content Marketing on Thrift Purchase Decisions Through
Instagram in Solo Raya. National Seminar on Tourism and Entrepreneurship (SNPK), 2,
455-466. https://doi.org/10.36441 /snpk.vol2.2023.152

Putro, SW (2014). The Influence of Service Quality and Product Quality on Customer

452



Proceeding of 4t International Conference on Research and Development (ICORAD)
Vol. 3 No. 2 (2024)

Page : 438-453

ISSN:2828-4925

DOI: 10.47841/icorad.v3i2.211

Satisfaction and Consumer Loyalty of Happy Garden Restaurant Surabaya. Journal of
Marketing Management, 2(1), 1-9.
http://publication.petra.ac.id/index.php/manajemen-pemasaran/article /view/1404
Sulistiyowati, W. (2017). Basic Statistics Textbook. Basic Statistics Textbook, 14(1), 15-31.
https://doi.org/10.21070/2017/978-979-3401-73-7
Widya, M., Jannah, AL, Ekonomi, F., & Semarang, U. (2023). Whitening in Semarang
University Students.

453



